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These guidelines demonstrate the use of  
design assets that relate to Special Olympics 
Leadership seminars and events. 

These guidelines do not demonstrate the use 
of an identity for a team or a department. 

Guidelines Introduction



Guidelines Introduction

These guidelines explain how the Special 
Olympics Leadership identity should be 
implemented. Examples of the identity in action 
are supplied along with guides on how to use the 
supplied artwork files.

The guidelines should be used in conjunction 
with the Special Olympics Brand Identity 
Guidelines to ensure we create consistent 
and engaging communications in line with the 
Special Olympics Master Brand.

Lorem ipsum dolor sit amet , consectetuer adipiscing  

elit, sed diam nonum my nibh euismod tincidunt ut  

laoreet dolore magna aliquam erat v olutpat. Ut wisi 

enim ad minim v eniam, quis nostrud ex erci tation 

ullamcorper suscipit lobortis nisl ut aliquip ex ea 

commodo consequat .

Lorem ipsum dolor sit amet , consectetuer adipiscing elit , sed diam nonum my nibh 

euismod tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut wisi enim ad minim  

veniam, quis nostrud ex erci tation ullamc orper suscipit lobortis nisl ut aliquip ex ea  

commodo consequat. Duis autem vel eum iriure dolor in hendrerit in vulput ate velit esse 

molestie consequat, vel illum dolore eu feugiat nulla facilisis at vero eros et accumsan et  

iusto odio dignissim qui blandit praesent luptatum zzril delenit augue duis dolore te 

feugait nulla facilisi.                Lorem ipsum dolor sit amet , cons ectetuer adipiscing elit , sed diam nonum my 

nibh euismod tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut wisi enim ad 

minim veniam, quis nostrud ex erci tation ullamcorper suscipit lobortis nisl ut aliquip ex ea  

commodo consequat. Lorem ipsum dolor sit amet, c onsectetuer adipiscing elit , sed diam 

nonummy nibh euismod tincidunt ut laoreet dolore magna aliquam erat  volutpat. Ut wisi  

enim ad minim v eniam, quis nostrud ex erci tatioeni m ad minim veniam, nostrud.c onse-

quat. Lorem ipsum dolor sit amet, c onsectetuer adipiscing elit, sed diam nonum my nibh 

euismod tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut wisi enim ad minim  

veniam, quis nostrud ex erci tatioenim ad minim v eniam, nostrud.

Our Approach
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Introduction

From Division to Inclusion 

The world today is full of volatility, anger, fear of difference, and pressures 
that divide people. Full inclusion offers hope – a way out of these divisions. 
People with intellectual disabilities (ID), epitomized by the athletes of 
Special Olympics, light the way by teaching others the true meaning of 
inclusion. They inspire a world where everyone accesses the opportunities 
in education, health, sport, work and social life that they deserve and want. 
To build such a world, it is no longer enough to create accommodations for 
people with disabilities; we need to tackle the unjust systems and attitudes 
that create exclusion. 

Special Olympics has for many years shown how to bring people, with and 
without disabilities together to play, learn and live Unified. The time has 
come to go even further, to ‘Lead Unified’, creating a new understanding of 
inclusive leadership that helps build communities where everyone’s skills and 
gifts are valued. 

A New Understanding of Leadership

“Inclusion doesn’t just happen.  
People leading make it happen.”
— Frost and Aldina, Building an inclusive 
organisation, 2019
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Unified Leadership

The Unified Leadership Approach
Building from sport, Unified Leadership 

teaches leaders of all abilities to value 

and learn from each other, and inspires 

change to create environments where 

people with ID succeed in meaningful 

jobs and roles.  

Why is Unified Leadership needed?
The leadership gifts and skills of 

people with ID are underestimated 

and undervalued. As a result, they 

are often unable to achieve their 

leadership potential because of the 

attitudes and behaviors of other 

leaders, and get few real opportunities 

to show what they can do. For this 

to change, training people with ID is 

no longer enough, we also need to 

educate the leaders around them.

How is Unified Leadership achieved?
Unified Leadership is not a standalone 

program – it is delivered through 

Special Olympics’ sports, health, 

youth and leadership work. The 

Unified Leadership approach involves 

education and training of leaders 

with and without disabilities, giving 

them tools and skills that build 

inclusive mindsets and behaviors. 

Where possible, people with ID lead 

the learning. Leaders are encouraged 

to improve their own behaviors and 

practices, and seek adaptations to 

the ‘norm’, to reach a situation where 

people with ID can successfully 

contribute and perform joint or 

independent jobs and roles. 

Introduction

“People with intellectual 
disabilities can absolutely 
teach leadership skills 
that help others. By simply 
engaging with this, particularly 
when they get training and 
support to truly listen and 
understand, other leaders 
begin to see and be reminded 
of things that matter most”

— Ben Haack, Special Olympics Athlete 
Leader and Member of the Board of 
Special Olympics International
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EcosystemIntroduction

How is Unified Leadership achieved? 
Unified Leadership is an approach that 

can be used by any leader, based on an 

understanding that they have a crucial role 

in facilitating an empowering environment 

where people with ID thrive. It is not a 

standalone program – it is integrated into 

Special Olympics’ sports, health, youth and 

leadership work. The Unified Leadership 

approach can also be adopted by any 

organization that seeks to make the most 

of the opportunities and performance 

improvements that true diversity and 

inclusion can bring.  

YOUTH

ATHLETE

SPORT

PROGRAM HEALTH



8 Leadership Identity Guidelines

Introduction

 

Leadership Areas

ATHLETE 
LEADERSHIP

UNIFIED
LEADERSHIP

HEALTH 
LEADERSHIP

SPORT 
LEADERSHIP

PROGRAM 
LEADERSHIP

YOUTH 
LEADERSHIP
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visual
identity



Visual Identity Building Blocks

Our visual identity is built on our 

core building blocks. These central 

elements provide the framework 

for all visual communications. 

Special Olympics Mark

Illustration Photography Area Identifiers

Background Graphics Typography

SHAPING 
MEANINGFUL 

CHANGE

Visual Identity

Leadership Identity Guidelines10
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It Takes Two

The core concept behind the identity is the idea 

of two people coming together and focusing 

on their relationship and interaction. This is 

represented by two abstract shapes coming 

together and highlighting the overlap between 

the two shapes. 
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It Takes Two

These shapes come together to create graphic 

background elements that can be used across 

all our communications.
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Visual Identity Area Identifiers

A range of area identifiers have been 

developed to represent the different 

work areas within Special Olympics 

Leadership. These can easily be used 

on stationery items and presentations 

(see 'Identity in Action' section).

  

ATHLETE 
LEADERSHIP

UNIFIED
LEADERSHIP

HEALTH 
LEADERSHIP

SPORT 
LEADERSHIP

PROGRAM 
LEADERSHIP

YOUTH 
LEADERSHIP
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Background Graphics

The background graphics are available 

in a range of different colors.
Unified Leadership

HealthAthlete Program Sport Youth

Additional Colors
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Formats

The background graphics are available 

in a range of different formats.
Web Banner

BadgePresentation 

Pull-up Banner
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Primary Color Palette

Each work area has been assigned a 

specific set of colors from the Special 

Olympics extended color palette.

Athlete LeadershipUnified Leadership

Sport Leadership

Health Leadership

Program LeadershipYouth Leadership
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Primary Color Palette

Dark Purple
Pantone® 2695C
Process: 80C/100M/0Y/40K
RGB: 61R/16G/99B
HEX: #3D1063

Mid Purple
Pantone® 267C
Process: 70C/100M/0Y/0K
RGB: 111R/44G/145B
HEX: #6F2C91

Light Purple
Pantone® 2587C
Process: 50C/100M/0Y/0K
RGB: 146R/39G/143B
HEX: #92278F

Extra Light Purple
Pantone® —
Process: 45C/70M/0Y/0K
RGB: 148R/99G/171B
HEX: #9463AB

Dark Orange
Pantone® 159C
Process: 0C/60M/100Y/45K
RGB: 152R/80G/6B
HEX: #985006

Mid Orange
Pantone® 1505C
Process: 0C/70M/100Y/5K
RGB: 230R/106G/31B
HEX: #E66A1F

Light Orange
Pantone® 137C
Process: 0C/50M/100Y/0K
RGB: 247R/148G/30B
HEX: #F7941E

Light Yellow
Pantone® 109C
Process: 0C/15M/100Y/0K
RGB: 255R/212G/0B
HEX: #FFD400

Dark Turquoise
Pantone® 3302C
Process: 90C/0M/50Y/50K
RGB: 0R/105G/94B
HEX: #00695E

Mid Turquoise
Pantone® 3282C
Process: 80C/0M/50Y/20K
RGB: 0R/151G/132B
HEX: #009784

Light Turquoise
Pantone® 3262C
Process: 70C/0M/50Y/0K
RGB: 57R/187G/157B
HEX: #39BB9D

Extra Light Turquoise
Pantone® —
Process: 55C/0M/35Y/0K
RGB:111R/199G/182B
HEX: #6FC7B6

Dark Red
Pantone® 202C
Process: 0C/100M/100Y/55K
RGB: 130R/0G/0B
HEX: #820000

Mid Red
Pantone® 1945C
Process: 0C/100M/100Y/20K
RGB: 196R/22G/28B
HEX: #C4161C

Light Red
Pantone® 186C
Process: 0C/100M/100Y/0K
RGB: 255R/0G/0B
HEX: #ED1C24

Extra Light Red
Pantone® —
Process: 0C/90M/75Y/0K
RGB: 240R/65G/70B
HEX: #EF4347

Dark Blue
Pantone® 294C
Process: 100C/80M/0Y/25K
RGB: 1R/59G/130B
HEX: #013B82

Mid Blue
Pantone® 300C
Process: 100C/50M/0Y/15K
RGB: 0R/99G/165B
HEX: #0063A5

Mid Orange
Pantone® 1505C
Process: 0C/70M/100Y/5K
RGB: 230R/106G/31B
HEX: #E66A1F

Light Blue
Pantone® Process Blue
Process: 100C/20M/0Y/0K
RGB: 0R/149G/218B
HEX: #0095DA

Dark Orange
Pantone® 159C
Process: 0C/60M/100Y/45K
RGB: 152R/80G/6B
HEX: #985006

Extra Light Blue
Pantone® —
Process: 65C/15M/0Y/0K
RGB: 80R/166G/211B
HEX: #50A6D3

Mid Purple
Pantone® 267C
Process: 70C/100M/0Y/0K
RGB: 111R/44G/145B
HEX: #6F2C91

Please use process color (CMYK) mix  

created for artwork. Colors should  

be visually matched to an up-to-date 

Pantone® Swatch. 

Athlete LeadershipUnified Leadership Sport LeadershipHealth Leadership Program Leadership Youth Leadership

Light Red
Pantone® 186C
Process: 0C/100M/100Y/0K
RGB: 255R/0G/0B
HEX: #ED1C24
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Secondary Color Palette

Light Green
Pantone® 382C
Process: 35C/0M/100Y/0K
RGB: 178R/210G/53B
HEX: #B2D235

Light Turquoise
Pantone® 3262C
Process: 70C/0M/50Y/0K
RGB: 57R/187G/157B
HEX: #39BB9D

Mid Blue
Pantone® 300C
Process: 100C/50M/0Y/15K
RGB: 0R/99G/165B
HEX: #0063A5

Light Blue
Pantone® Process Blue
Process: 100C/20M/0Y/0K
RGB: 0R/149G/218B
HEX: #0095DA

Light Mauve
Pantone® —
Process: 65C/60M/0Y/0K
RGB: 107R/107G/194B
HEX: #6B6BC2

Light Green
Pantone® 382C
Process: 35C/0M/100Y/0K
RGB: 178R/210G/53B
HEX: #B2D235

Light Turquoise
Pantone® 3262C
Process: 70C/0M/50Y/0K
RGB: 57R/187G/157B
HEX: #39BB9D

Dark Mauve
Pantone® —
Process: 89C/100M/25Y/23K
RGB: 61R/18G/99B
HEX: #3D1263

Light Red
Pantone® 186C
Process: 0C/100M/100Y/0K
RGB: 255R/0G/0B
HEX: #ED1C24

Light Orange
Pantone® 137C
Process: 0C/50M/100Y/0K
RGB: 247R/148G/30B
HEX: #F7941E

Mid Orange
Pantone® 1505C
Process: 0C/70M/100Y/5K
RGB: 230R/106G/31B
HEX: #E66A1F

Mid Magenta
Pantone® 215C
Process: 0C/100M/20Y/20K
RGB: 196R/0G/99B
HEX: #C40063

Variation 1 Variation 2 Variation 3A range of alternative color sets have been 

developed for general communications.
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Mark Positioning

Special Olympics Mark
We use our Special Olympics mark on all our 

communications. The mark should always be 

positioned in the top right corner.
ATHLETE LEADERSHIP ATHLETE  LEADERSHIP

Landscape

Close-up

Portrait

ATHLETE LEADERSHIP



Visual Identity Typography

GT WALSHEIM IS THE 
TYPEFACE WE USE 
FOR HEADINGS AND 
STATEMENTS.
—
We pair GT Walsheim with Ubuntu, the 

main Special Olympics typeface.

Visual Identity

20 Unified Leadership Program Identity Guidelines
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Typography

We use GT Walsheim Condensed Bold in 'all 

caps' for statements or headings across all our 

communications. 

Ubuntu is used for body copy and captions.

Landscape (Presentation Title Slide) Portrait (Pull-up Banner)
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Typography

Strong Statements
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Inspirational Phrases

Typography
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TypographyVisual Identity

Presentation Slides Publication Covers

Lorem ipsum dolor sit amet , consectetuer adipiscing  

elit, sed diam nonum my nibh euismod tincidunt ut  

laoreet dolore magna aliquam erat v olutpat. Ut wisi 

enim ad minim v eniam, quis nostrud ex erci tation 

ullamcorper suscipit lobortis nisl ut aliquip ex ea 

commodo consequat .
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IllustrationsVisual Identity

Unified Leadership

Youth Leadership

Athlete Leadership

Health Leadership

Sport Leadership Program Leadership

Each leadership work area has 

been assigned a specific illustration 

demonstrating leaders working 

together with their team members.
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Illustrations in Action

Presentation Slide

Publication Cover

Area Identifier

Web BannerPull-up Banner

UNIFIED
LEADERSHIP
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Photography

Alongside illustration, photography can 

be used across our communications.

Templates for image treatment in 

Illustrator format are available to 

download on the Special Olympics 

Leadership Dropbox Showcase. 

For a step by step tutorial on how to 
treat imagery, see page 28.

Variation 1 Variation 2 Variation 3
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Image Treatment

Follow these steps to treat selected images:

1.	 Import image in Photoshop

2.	 Remove background 

3.	 Convert to grayscale (Image > Mode > Grayscale)

4.	 Increase brightness and contrast in the 
Adjustments panel

5.	 Flatten layers (select image layer and adjustment 
layer in Layers panel, right click and select Flatten 
Image)

6.	 Export as TIFF (File> Save as> TIFF)

7.	 Open 'image treatment' Illustrator file (available 
to download on Dropbox Showcase)

8.	 Select existing image with direct selection tool

9.	 Replace image: Go to links panel and relink image 
you want to replace

10.	 Adjust image placement with direct selection tool 
accordingly

11.	 Export file (File > Export > Export as > PNG > Select 
artboard > Export)

1

4

8

2

5

9

3

6

10 11
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Messaging

INSPIRING
MEANINGFUL
CHANGE

SHOWING 
THE WAY

ADVOCATING
FOR BETTER
HEALTH

ACHIEVING
POTENTIAL

INCLUDING
BY EXAMPLE

BUILDING
THE FUTURE

A range of statements have been 

developed for the different Leadership 

work areas.

Unified Leadership Athlete Leadership

Health Leadership

Sport Leadership

Program LeadershipYouth Leadership
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identity
in action
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Presentation SlidesIdentity in Action

Presentation Title Slides

Unified Leadership Athlete Leadership Sport Leadership Program Leadership

Health Leadership Youth Leadership
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Identity in Action Presentation Slides

Internal Presentation Slides

Unified Leadership Athlete Leadership Sport Leadership Program Leadership

Health Leadership Youth Leadership

 

 

 
 

.

 

 

.

 

 
 

unified leadership
athlete leadership

health leadership

sport leadership

youth leadership

program leadership
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Lorem ipsum dolor sit amet , consectetuer adipiscing  

elit, sed diam nonummy nibh euismod tincidunt ut  

laoreet dolore magna aliquam erat v olutpat. Ut wisi 

enim ad minim v eniam, quis nostrud ex erci tation 

ullamcorper suscipit lobortis nisl ut aliquip ex ea 

commodo consequat .

Identity in Action Presentation Slides

Work Areas

Work areas — Overview
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Identity in Action Documents

Area Identifier — Placement on documents

Athlete Leadership Program Leadership Sport Leadership Youth Leadership Health Leadership

     

Unified Leadership Program

Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed diam nonummy 

nibh euismod tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut 

wisi enim ad minim veniam, quis nostrud exerci tation ullamcorper suscipit 

lobortis nisl ut aliquip ex ea commodo consequat. Duis autem vel eum 

iriure dolor in hendrerit in vulputate velit esse molestie consequat, vel 

illum dolore eu feugiat nulla facilisis at vero eros et accumsan et iusto odio 

dignissim qui blandit praesent luptatum zzril delenit augue duis dolore te 

feugait nulla facilisi.

                Lorem ipsum dolor sit amet, cons ectetuer adipiscing elit, sed diam 

nonummy nibh euismod tincidunt ut laoreet dolore magna aliquam erat vo-

lutpat. Ut wisi enim ad minim veniam, quis nostrud exerci tation ullamcorper 

suscipit lobortis nisl ut aliquip ex ea commodo consequat. Lorem ipsum dolor 

sit amet, consectetuer adipiscing elit, sed diam nonummy nibh euismod 

tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut wisi enim ad 

minim veniam, quis nostrud exerci tation .

Unified Leadership Program

Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed diam nonummy 

nibh euismod tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut 

wisi enim ad minim veniam, quis nostrud exerci tation ullamcorper suscipit 

lobortis nisl ut aliquip ex ea commodo consequat. Duis autem vel eum 

iriure dolor in hendrerit in vulputate velit esse molestie consequat, vel 

illum dolore eu feugiat nulla facilisis at vero eros et accumsan et iusto odio 

dignissim qui blandit praesent luptatum zzril delenit augue duis dolore te 

feugait nulla facilisi.

                Lorem ipsum dolor sit amet, cons ectetuer adipiscing elit, sed diam 

nonummy nibh euismod tincidunt ut laoreet dolore magna aliquam erat vo-

lutpat. Ut wisi enim ad minim veniam, quis nostrud exerci tation ullamcorper 

suscipit lobortis nisl ut aliquip ex ea commodo consequat. Lorem ipsum dolor 

sit amet, consectetuer adipiscing elit, sed diam nonummy nibh euismod 

tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut wisi enim ad 

minim veniam, quis nostrud exerci tation .

Unified Leadership Program

Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed diam nonummy 

nibh euismod tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut 

wisi enim ad minim veniam, quis nostrud exerci tation ullamcorper suscipit 

lobortis nisl ut aliquip ex ea commodo consequat. Duis autem vel eum 

iriure dolor in hendrerit in vulputate velit esse molestie consequat, vel 

illum dolore eu feugiat nulla facilisis at vero eros et accumsan et iusto odio 

dignissim qui blandit praesent luptatum zzril delenit augue duis dolore te 

feugait nulla facilisi.

                Lorem ipsum dolor sit amet, cons ectetuer adipiscing elit, sed diam 

nonummy nibh euismod tincidunt ut laoreet dolore magna aliquam erat vo-

lutpat. Ut wisi enim ad minim veniam, quis nostrud exerci tation ullamcorper 

suscipit lobortis nisl ut aliquip ex ea commodo consequat. Lorem ipsum dolor 

sit amet, consectetuer adipiscing elit, sed diam nonummy nibh euismod 

tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut wisi enim ad 

minim veniam, quis nostrud exerci tation .

Unified Leadership Program

Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed diam nonummy 

nibh euismod tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut 

wisi enim ad minim veniam, quis nostrud exerci tation ullamcorper suscipit 

lobortis nisl ut aliquip ex ea commodo consequat. Duis autem vel eum 

iriure dolor in hendrerit in vulputate velit esse molestie consequat, vel 

illum dolore eu feugiat nulla facilisis at vero eros et accumsan et iusto odio 

dignissim qui blandit praesent luptatum zzril delenit augue duis dolore te 

feugait nulla facilisi.

                Lorem ipsum dolor sit amet, cons ectetuer adipiscing elit, sed diam 

nonummy nibh euismod tincidunt ut laoreet dolore magna aliquam erat vo-

lutpat. Ut wisi enim ad minim veniam, quis nostrud exerci tation ullamcorper 

suscipit lobortis nisl ut aliquip ex ea commodo consequat. Lorem ipsum dolor 

sit amet, consectetuer adipiscing elit, sed diam nonummy nibh euismod 

tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut wisi enim ad 

minim veniam, quis nostrud exerci tation .

Unified Leadership Program

Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed diam nonummy 

nibh euismod tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut 

wisi enim ad minim veniam, quis nostrud exerci tation ullamcorper suscipit 

lobortis nisl ut aliquip ex ea commodo consequat. Duis autem vel eum 

iriure dolor in hendrerit in vulputate velit esse molestie consequat, vel 

illum dolore eu feugiat nulla facilisis at vero eros et accumsan et iusto odio 

dignissim qui blandit praesent luptatum zzril delenit augue duis dolore te 

feugait nulla facilisi.

                Lorem ipsum dolor sit amet, cons ectetuer adipiscing elit, sed diam 

nonummy nibh euismod tincidunt ut laoreet dolore magna aliquam erat vo-

lutpat. Ut wisi enim ad minim veniam, quis nostrud exerci tation ullamcorper 

suscipit lobortis nisl ut aliquip ex ea commodo consequat. Lorem ipsum dolor 

sit amet, consectetuer adipiscing elit, sed diam nonummy nibh euismod 

tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut wisi enim ad 

minim veniam, quis nostrud exerci tation .

ATHLETE 
LEADERSHIP

HEALTH 
LEADERSHIP

SPORT 
LEADERSHIP

PROGRAM 
LEADERSHIP

YOUTH 
LEADERSHIP
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Leadership Branding 
Alongside Other Events

The Special Olympics Leadership branding

will work alongside other events.

lead to
include
REGION

special olympics
lead to include

YOUTH LEADERSHIP

special olympics
lead to include

GLOBAL YOUTH ENGAGEMENT PARTNERS 

region

REGIONAL YOUTH SUMMIT

LEAD TO INCLUDE MADE POSSIBLE BY

SUPPORTED BY



36 Leadership Identity Guidelines

Identity in Action Pull-up Banners

Athlete LeadershipUnified Leadership Health Leadership Program Leadership Sport Leadership Youth Leadership

Pull-up banners for events
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Identity in Action Website

Website banner

OUR WORK GET IN VO LVED ST ORIES ABOUT DON ATE

Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed 
diam nonummy nibh euismod tincidunt ut laoreet dolore 

magna aliquam erat volutpat. Ut wisi enim ad minim veniam, 
quis nostrud exerci tation ullamcorper suscipit lobortis nisl ut 

aliquip ex ea commodo consequat. 

Unified Leadership
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Identity in Action Badges
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Identity in Action Publication Covers
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Management Contact & Resources

Every single participant in the Special Olympics Movement can play a role in 
aligning and strengthening our brand around the world. These guidelines as 
well as a comprehensive suite of tools, messaging materials and templates are 
available for all to download from shorturl.at/juHIY

We encourage you to contact nafiouni@specialolympics.org with any 
questions, queries or comments you may have at any stage.
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thank you




